Show Commission Duty Notes
Guide for Show Managers and Entry Clerks
Version 2.0 January 2014

January 2014

-1

of 23 -

v0.2 (draft)

Contents
Contents
Show Administration ................................................................................................................. 4
On receipt of a Show Application: ......................................................................................... 4
If a club decides not to run a show: ...................................................................................... 4
If a club applies to take over a date from another club: ....................................................... 4
Running Shows .......................................................................................................................... 4
Booking judges ...................................................................................................................... 4
Judges Payment ..................................................................................................................... 5
Penning for the Show ............................................................................................................ 5
Judges Hotels ......................................................................................................................... 5
Best in Show Panel .................................................................................................................... 5
Running the Secretariat ............................................................................................................. 6
During Vetting In ............................................................................................................... 6
Pre-Open Judging .............................................................................................................. 6
During Open judging.......................................................................................................... 6
Entering results into the computer ................................................................................... 7
Pre-BIS Panel ..................................................................................................................... 8
BIS Panel ............................................................................................................................ 8
End of Show ....................................................................................................................... 8
ENTRY CLERK’S GUIDE ............................................................................................................. 10
General ................................................................................................................................ 10
Equipment Required............................................................................................................ 10
Getting Started .................................................................................................................... 10
Checking the Entry Forms.................................................................................................... 10
Classes 13a (Novice Class) and 13b (Control Class) ......................................................... 11
Tally Envelopes .................................................................................................................... 11
Hand-over to the Show Manager ........................................................................................ 11
Using the Excel Spreadsheet ............................................................................................... 12
NOTES ON SHOW PREPARATION FILES ............................................................................... 15
BEFORE YOU START ............................................................................................................. 15
When opened, the template files that use macros/scripts will produce a warning
indicating that the file contains macros, and that they may be harmful. These files

January 2014

-2

of 23 -

v0.2 (draft)

contain nothing harmful, and you must choose ‘Enable Macro’ for them to work as
intended.................................................................................................................................. 15
THINGS YOU WILL NEED ...................................................................................................... 16
Using the 2-day spreadsheet ........................................................................................... 16
FILES INCLUDED WITH THIS DISTRIBUTION ..................................................................... 17
Important notes for the Show Manager ......................................................................... 19
Winners Show.......................................................................................................................... 21
Winners Show perpetual trophies................................................................................... 21
Show Year ................................................................................................................................ 22
Annual Awards Dinner......................................................................................................... 23
Trophies and Awards ........................................................................................................... 23
Perpetual trophies: .......................................................................................................... 23
FB glass perpetual trophies: ............................................................................................ 23

January 2014

-3

of 23 -

v0.2 (draft)

Show Administration
On receipt of a Show Application:
Circulate to the Show Commission for discussion. If the application is approved, notify the
General Secretary who will advise the Club. FB then applies to FIFe for it to be displayed on
the FIFe website and the club can then book the judges. At the same time the date will be
added to the FB website.

If a club decides not to run a show:
Via the General Secretary, the FB clubs are notified and invited to apply to take the date. The
first club to submit a show application (that’s approved) gets the date.

If a club applies to take over a date from another club:
The original club is written to (under ‘right to repeat’) and asked to submit a show
application within 14 days. If they don’t, they lose the date and it’s offered to other clubs
above.

Running Shows
Booking judges
Using the current judges list, email judges in the relevant category/ies. At least one judge
needs to be all breed. Update the ‘judges invited’ list with the details, and change ‘inv’ to
‘conf’ when the judge confirms.
Example email:
Dear Mr/s xxxxx
On behalf of Felis Britannica, UK, I would like to invite you to judge at our xxxx-day Show to
be held in XXXX, UK on xxxxxxxx 2011.
I await your early reply.

Kind regards,
Josie Hughes
Acting Chair, FB Show Commission
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Judges Payment
A one day show 100€ each plus their travelling expenses. If they don’t go back on Sunday
and have to stay over as well as the hotel there is £15/£20 for an evening meal.
A two day show 200€ each.

Penning for the Show
Bella Penning (bellapenning@hotmail.com) need contacting once the date is agreed to ask
for a quote for penning the show. Once they send this, it needs agreeing and a deposit
paying.

Judges Hotels
The judges need booking into a hotel near the show venue for the night before the show.
Someone from the Show Team also needs to stay in the same hotel to ‘host’ them for dinner
in the evening. Aim for £50-60 B&B, with £20-25 allowance for dinner.
If the judges aren’t flying home the evening of the show, they also need a hotel booking near
to the airport.

Best in Show Panel
HHP can be split LH/SH or MN/FN but don’t complete in the overall best in show.

New Breeds (Australian Mists, Tiffanies) and New varieties (eg the Ocicat that has diff
colours / patterns) can be treated, in effect, like two more categories. The judge can
nominate kitten, junior, male neuter, female neuter, adult male and adult female in exactly
the same way as for categories I-V, so, in theory, if one judge had the Mists, another had
Tiffanies, and there were cats from all classes, we could then have a New Breed BIS resulting
in a Best New Breed. The same for new variety. However, the winner of both of these does
not go forward to the overall best in show.
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Running the Secretariat
During Vetting In

•

Remind exhibitors to check catalogue for entry accuracy. Cleary state that it
is their responsibility to ensure everything is correct before judging.
Corrections highlighted after judging commences, and that were evident in
the catalogue, are likely to lead to awards being lost on the day.

•

On receipt of correction, update pc and amend judges’ books. Remember to
move papers between judges if amendment changes the judging group on
the day.

•

Just prior to closing vetting in, send someone to collect the judges. Have a
place for the judges to examine their judge’s book and have a tea/coffee.

Pre-Open Judging

•

Take attendance sheets to secretariat (someone must collate the sheets from
the vets and the gate). It is essential that this happens promptly; at least 15
minutes before judging begins.

•

Whilst judges are being collected, have Chief Steward gather stewards
together and organise colour assessment/novice class/control class papers in
preparation for judges’ arrival.

•

As soon as judges arrive, do assessments – away from judging ring if
possible e.g. in separate room. This helps control when Open judging should
commence.

•

Pass assessment results to secretariat as they are completed. Allow 5-10
minutes after completion before Open judging commences – a good time for
the judges to have a coffee.

•

Ensure all changes are processed. Where there is a change of judge,
remember to move judge’s report form and steward card to the new judge, as
well as correcting the information on the judges report forms and sheets.

•

Print corrected judges’ sheets that will be used as masters by stewards for
amendments/judge changes/absentees – if time, reprint a copy for judges as
well.

•

At this point all should be in place for judging to begin. The secretariat will be
quiet now until the first reports arrive, so take a break/have breakfast.

During Open judging

•

Have an in-tray in the secretariat where the stewards can leave paperwork.

•

It is essential that all paperwork is processed quickly. Ensure that the Chief
Steward is regularly checking the progress of the judges, and that critiques
are brought to the secretariat as soon as the judge has finished with them.
Place the critiques into numeric order as you receive them.

•

Use a copy of the master judge’s sheets printed out previously as a reference
for judging class, colour, BIVs, etc. If anything has been changed on the
judge’s critique (class, colour, etc), then this must correspond with the master
sheets. If not query it with the judge’s steward, as it is likely to be a change
that has not been communicated to the secretariat. Once verified as a
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necessary change, update the details on the computer, and verify that the
judge’s books have been amended, and change of judge implemented if
necessary. If the change will impact judging that has already finished, the cat
will need to be withdrawn from competition, and any awards lost.
•

Each critique placed in the tray should be checked to ensure that the correct
award has been given for the class, and that the judge has signed it. Use the
master judge’s sheets to see if a BIV is available for the colour class (these
will be listed at the end of each colour group). You will need to cross
reference all cats present for the colour class to verify this – marking the
results on the master judge’s sheet can help track this. If a BIV has not been
awarded where one is expected, this should be queried with the judge.
Likewise, if a BIV has been awarded, where one isn’t available, this must be
queried with the judge. The master judges sheets also allow you to
immediately see that the correct placements and awards have been awarded
for each colour group e.g. no missing certificates (unless withheld); no
missing placements (CAC, EX2, EX4) and no duplicate placements (CAC,
EX2, EX2).

•

When happy with critique, the checker should then initial the bottom left
corner to show this has been done.

•

The critique is then split into its two parts. The copy is given to the person on
the computer for them to enter the result. The original is used to enter the
result on the corresponding Certificate of Award (CoA) card and to issue any
BIV rosettes.

•

The critique form is now finished with and can be sent out (together with any
BIV rosettes if appropriate) or it can be held back and sent out later with its
corresponding CoA card.

•

When a Nomination sheet comes in from a judge, enter NOM on the CoA
card for each cat nominated. Then mark up a nomination rosette for each cat
nominated. All the CoAs (and critiques if held back) for that judge, for that
category, can now be sent out together with the NOM rosettes. Initial the
sheet to indicate that CoA has been updated. Pass the nomination sheets on
for the details to be entered into the computer.

Entering results into the computer

•

The judgement should be placed in the column headed ‘CERTIFICATE’. The
program will check that it is a valid certificate (if applicable) for the class. If
the certificate was withheld (i.e. a class 1-10 is awarded an EX1), enter the
result as ‘EX1 W/H’. Check that the judge has made it clear on the critique
that the certificate is withheld.

•

If a BIV has been awarded, place ‘Y’ in the column headed ‘BIV’.

•

When receiving the nomination sheets, enter a ‘Y’ in the column headed
‘NOM’. For category I to IV and Pets, the program automatically completes
the BIS sheets and checks that there are no duplicate nominations. For
Unrecognised Breeds & Varieties, the nomination has to be manually entered
into the BIS sheet – only the number has to be entered; the other details are
looked up.

•

Ensure the critiques stay in numeric order as you process them.
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Pre-BIS Panel

•

Instruct the Chief Steward to re-arrange the judge’s rings for the BIS
Presentation – cages to be cleaned, tables positioned, disinfectant checked,
podiums (if used) set out, stewards and judges informed of intended start
time, etc. Ask someone to make an announcement on the microphone to let
everyone know when BIS will start.

•

BIS sheets for Category I, II, III & IV plus the Domestic pets are automatically
filled-in by the program. Sheets for Unrecognised Breeds/Varieties and any
Specials are not, and should have been entered manually as the Nomination
sheets were received. Using the Nomination sheets received by the judges,
cross check that the correct cats are shown on the BIS sheets for each
category and judge.

•

When you are sure that the BIS sheets are correct, print out 3 copies of the
‘BIS_Sheets’ plus one copy of the ‘Judges_BIS_Sheets’ for each judge and
student judge present.

•

Print the steward cards that are required for BIS. Use the ‘Steward Cards
Template’ for this – it will ask you if you want all cards printed, or only the
ones for BIS. Choose the latter option.

•

DO NOT FORGET TO MAKE ARRANGEMENTS FOR REFEREE JUDGES
IN THE EVENT OF A TIE IN THE VOTING.

•

Give one set of the ‘BIS Sheets’ and the printed steward cards to the Chief
Steward, so they can sort everything into order. Give another set to the
person on the microphone, and the final set to the show recorder.

BIS Panel

•

The results of BIS should be entered into the show program as they happen –
this is so that complete show results are given to the judges at the end of BIS.
This can be done by the show recorder, as they will be recording the results
on the BIS sheets already, or another person can do it.

•

When BIS is complete, print the results sheets – one copy for each judge and
student judge, and give to them with their catalogue. If it is a 2-day show,
catalogues must not be given to the judges until after BIS on the second
day.

End of Show

•

Give the judges their copy of the catalogue, results sheet and present.
Ensure they are aware of their onward travel arrangement. In particular, if
they are staying overnight for a flight the next day, ensure that have details of
their hotel, travel arrangements from the hotel to the airport and provide them
with a contact number should they experience any problems before they get
their flight home.

•

Ensure you have safely retrieved the nomination sheets, copy judge’s
critiques, recorder’s BIS sheets and veterinary rejection forms.

•

Send any colour assessment/control class/novice class paperwork to the
registrar with a copy of the catalogue.

•

The Show Commission should receive the judge’s critiques, marked-up BIS
papers and ‘Results Catalogue’. If the BIS results have been entered during
BIS, then this can be generated and printed at the close of the show.
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•

Veterinary rejection forms should be forwarded to the FB veterinary officer
within 24 hours of the show.
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ENTRY CLERK’S GUIDE
General
This is a section of show administration that can be done by one person. It is a task that only needs common sense
and concentration. It is vital that all stages are followed in the correct order, otherwise mistakes will occur and double
checks cannot be made. Mistakes during this stage can make it impossible to get the penning correct, cause cats to
lose their certificates, etc.
As Entry Clerk, your name and address will be on the show flier and the closing date was traditionally about a month
before the show date, but this has proven difficult to enforce if entries are to be reasonable. It is therefore now more
usual to keep entries open up until the weekend before the show – this makes it even more important to get the data
entered accurately, as there is less time available to create the catalogue, generate the paperwork all the other tasks
that cannot be started until entries are closed. It is important that entries are processed each day as they arrive. This
will ensure that the last minute is not a panic.

Equipment Required











Plastic punched pockets to put each entry in.
Lever arch file to place the entries after they have been dealt with.
Calculator
Red pen
EMS code list
Tally envelopes
Container for the tally envelopes
Bank paying in book
Computer with Microsoft Word and Excel.
The Felis Britannica show software.

Getting Started
On receiving the show entry, open the envelope and make sure that nothing is left inside. It has been known for
cheques to be thrown away by mistake. Deal with each entry as you open it otherwise they can easily get mixed up.
Check that the show and show date filled in by the exhibitor at the top of the form, is correct.
In order to check the show fees it may be useful to make yourself a chart of show fees to refer to. No show entries
should be processed unless on the official entry form and with the correct fees. Discounts may apply for certain
entries. Ensure you are familiar with these, and account for them in any calculations.
Note how many cats the exhibitor has entered and if the cats are sharing pens, whether they need extra passes,
adverts, catalogues or any donations. Work out the amount you think it should be and check that the exhibitor has
sent the correct amount. It is handy to have a pad and a calculator alongside.
Should you need to amend or alter anything on the entry forms please do it in red. There is then no confusion or
arguments.

Checking the Entry Forms
The most common mistakes are:
 Class – make sure the class entered corresponds with any title;
 Sex – the show software will show an error if you try to enter an entire cat in a neuter class or the other way
round but this should be checked carefully;
 EMS code – the show software checks that the EMS code entered is a valid one but that’s all. Some exhibitors do
not know their cats EMS code and will only enter the colour description and leave it to you to work out! Have a
copy of the EMS code list to hand for checking any that you are not sure of;
 Date of birth - the show software checks the date of birth for kittens and will tell you if they have been entered in
the wrong class.

Classes 13a (Novice Class) and 13b (Control Class)
Any entries received for classes 13a or 13b must be accompanied by a letter stating why the cat is entered into the
class. For class 13b a copy of the cat’s pedigree must also be enclosed.
Remember – if in doubt ask. Always check with the exhibitor if anything on the entry form is not clear.
Once this is done the cats can then be entered into the show programme. They need not be placed in EMS code order
as the programme will do this when the Show Manager comes to create the catalogue. Enter each cat’s details into
the Entries spreadsheet, the exhibitor’s details into the Exhibitor list, and on the Breakdown sheet enter the number
of cats, pens, passes, catalogues etc and monies paid. Details of using the show programme are below.
Remember to bank cheques at regular intervals so that you don’t bankrupt your club!!

Tally Envelopes
At this stage when you have checked the entry NOW is the time to write out the tally envelope. It is most important
whilst you have all the information to hand to do this now. Process each exhibitor’s entry form individually - do not
wait until you have finished them all, otherwise you have to look at each one again and this is time consuming.













Make sure that all the envelope flaps are facing the same way.
Write the exhibitors name (last name first) at the top left of the envelope.
Underneath write the cat/cats name/s – use the registered name, not pet names. Make sure you leave enough
space at the left-hand edge for the cats to be numbered, and at the right-hand edge for the pen numbers to be
written in later.
Bracket together any cats sharing pens – this is most important, as this is the ONLY record of which cats share
pens, and will be used by the show manager to pen the cats. If this is wrong, the show manager will have to go
through all received entry forms to re-create the information!!!
If the cat is a single cat in a single pen put an asterisk after the cat’s name – this will be essential information
when the show manager does the penning plan.
At the bottom left of the envelope make a note of any extra passes/catalogues ordered.
At the bottom right, make a note of any monies owing or to be refunded.
On the back of the envelope the exhibitor can be thanked for any donation.
The envelopes are then placed in alphabetical order in a suitable box.
Enter the details into the show programme (see below).

Once you have got this far, number the entry form – top right corner (take the number from the field called ‘INDEX’
displayed in the dialogue that you type the entry details into), hole-punch the entry form and put the entry in the ring
binder. Now move onto the next entry.

Hand-over to the Show Manager
On a regular basis you will need to let the Show Manager know what entries have been received so that they can
order trophies and rosettes, or chase entries if necessary.
Once you reach the agreed cut-off date for entries, you will need to hand over everything you have processed
including the show spreadsheet to the Show Manager so that they can complete the catalogue and judges paperwork.

Remember!






No entries without money, unless agreed with the show manager.
Process entries as they come in to avoid build up.
Write out the tally envelopes as you process each entry.
Use a red pen for any corrections you make on the entry forms.
Communicate with your team!

Using the Excel Spreadsheet
FOR THE PROGRAM TO WORK, macros must be enabled. In versions of Excel prior to 2007, this is done from the
Tools►Macro►Security menu, and should be set to ‘Medium’. This means that you will be asked if you want to
enable macros whenever you open a file that contains them.
For Excel 2007, the default will be for a Security warning to appear at the top of the opened sheet. Choose Options,
and select ‘Enable Content’. If this does not appear, you will need to go to Excel options, and the Security/Trust
Centre for Macros to change the security level.
For the show spreadsheet you must choose ‘enable macros’ if asked.
There are 4 sheets that you will use: ‘Entries’, 'Show Details', 'Breakdown' and 'Exhibitor List'.
•

Entries - this is where the cat’s details go.

•

Show details - this only has to be edited once, to enter the name of the show and the date

•

Breakdown - this is used to track what each exhibitor wants – types & number of pens, payment details, side
classes, etc.

•

Exhibitors - names & club of exhibitors - this is used for the catalogue production

Before starting anything, enter the name of the show and the date of the show in the 'Show Details' sheet. The rest is
completed by the Show Manager once entries have closed. In general you can then forget about this sheet and the
show manager may have already entered the show name & date. It is worth referring to this sheet from time to time
to ensure there is no red, sad face () next to the number of entries for a particular day. If this is visible it highlights a
discrepancy between the number of cats entered for each day, and the number of cats in pen (from the breakdown).
It is best to resolve why these do not correlate as soon as you notice the problem, rather than leave it until all entries
are received, since checking all entries and penning can take a long time.
Now you can begin to process the exhibitor’s individual entry forms. To speed entry, there is a database of cats that
have entered previous FB shows. To put a new entry into the spreadsheet, highlight a cell in the row you want to
enter the cat – this will usually be the next blank row, unless you want to overwrite a previous entry. If there are
details in the currently selected row, you will be given the option to either amend or overwrite the entry in that row.
Along the top row of the ‘Entries’ sheet are a number of buttons. The one you will use most is the one labelled ‘ADD /
EDIT ENTRY’. You will need to press this button each time you wish to enter a new cat, or amend previously entered
details. The other buttons are:
‘SORT BY EMS’ – this will sort the entries into the correct order for the catalogue.
‘SORT BY NUMBER’ – this option is only useful after the entries have been numbered, which usually doesn’t happen
until after entries have been closed. Primarily of use to the show manger if they have to accept late entries, after the
entries have been numbered.
‘SORT BY INDEX’ – this will sort the entries into the order of the generated index number (see below). This will, in
effect, be the order you processed the entries, and can be useful if you need to get the entries back into the same
order as the processed entry forms.
‘NUMBER ENTRIES’ – this is normally not done until after entries have been closed, and by the show manager. It
assigns a catalogue number to all exhibits.
‘CREATE PENNING DATABASE’ – used by the show manager to generate paperwork.
‘PRINT BIS SHEETS’ – used by the show manager to generate paperwork.

‘EMAIL TO SHOW MANAGER’ – due to the size of the entire programme, pressing this button will email only the
necessary sheets to the show manager. Your show manager will tell you how often to do this, so that they can track
entry progress.
To begin entering details, ensure you are on a blank row (or the row containing the exhibit you wish to amend) and
press the ‘ADD / EDIT ENTRY’ button – this will ask you for the name of the entry. If there is a match, then those
details will be filled in. If there are close matches, you will be given a number of choices to choose from. If none of
the matches is the cat you are looking for than choose the last entry in the list – this will be the search string you
entered, and when selected will present you with a blank form to complete for a new entry in the database. Just
complete the name fully at the top of the form, and fill in the other fields.
HINT: IT IS BEST TO ENTER ONLY PART OF THE CAT’S NAME, AND ALLOW THE PROGRAM TO OFFER A NUMBER OF
ALTERNATIVES IN THE DATABASE. If too many results are returned, add more to the search text and try again.
e.g An exhibitor is entering ‘Chuffy Too Strings’. Try searching for ‘Chuffy’, which will return all cats with the prefix
‘Chuffy’. This has the advantage that it will return ‘Chuffy Two Strings as an option, if the exhibitor meant ‘Two’ not
‘Too’. If there are too many results returned with the first search, then reduce the number by trying ‘Chuffy T’.
When NO results are returned, it is worth trying some alternative search strings, as exhibitors often misspell part of
their own cat’s name, and/or handwriting can often be a problem.
As you process each entry form number it (the top right corner is a good place to write the number), and put the
number you've written on the form into the ‘Index’ field. The program will normally automatically complete this field
with the next available number, so under normal circumstances you shouldn’t need to alter it – just copy this number
onto the entry form. This helps if there are any queries later on. When you have finished with the form you should
file it in a ring binder.
NEVER TYPE INTO THE ‘Entries’ SPREADSHEET DIRECTLY – ALWAYS USE THE BUTTON TO ADD, OVERWRITE OR
MODIFY ENTRIES!!!
The fields are:
TITLE – any title the cat may have.
PRE – this is primarily for country codes. These will usually take the form of 1 or 2 letters before the cat’s name and
will typically be in the form (N) (for Norway) or S* (Sweden). Either brackets or an asterisk may be encountered, but
FB uses an asterisk for registration purposes, so it is best always to use the asterisk form. E.g. change (N) to N*. See
also POST. DO NOT INCLUDE THE COUNTRY CODE IN THE CAT NAME FIELD. SINGLE OR DOUBLE LETTERS AT THE
START OR END OF A NAME ARE USUALLY COUNTRY CODES, AND ARE OFTEN IN BRACKETS OR INCLUDE A *. If in
doubt, check with the FB show commission or registrar.
CAT NAME – the cat’s name, without titles, country codes, etc.
POST - See Pre. For prefixes a country code should be before the name, and so in PRE but for breeding suffixes, the
country code should be AFTER the name and so in POST. In the case of a suffix, the asterisk appears before the
country code i.e. for Norway it becomes *N. This field is also used for suffix titles – DM, JW & DSM. If the cat has both
a country code and a suffix title, just combine then with the country code first e.g. ‘*N JW’.
EMS Code – the EMS code from the entry form. Carefully compare the EMS code and the colour description –
exhibitors often put things that don’t match!!! If it is not obvious what they meant, contact the exhibitor and check
with them. It is better to pick up inconsistencies now than after the catalogue has been prepared, or at the show. The
‘O’ column (titled NULL) indicates if the EMS code is recognised. ‘#N/A’ indicates a problem. A number indicates that
it is OK. Be careful to put EMS codes in the correct format – exhibitors OFTEN get them wrong. Extra spaces in the
EMS code will also confuse the program so, if your EMS code is not recognised, first check for extra spaces either
before or after the EMS code. ALSO NOTE, ALL NUMERIC PARTS OF THE EMS CODE HAVE TO BE IN INCREASING
ORDER e.g. MCO n 09 23 NOT MCO n 23 09
SEX – M, F, MN or FN only. Kittens should always be entered as M or F, regardless of whether or not they are
neutered.
DOB – enter in the format 13-may-08 to avoid any ambiguity.

CLASS – the competition class the cat is entered in. Check this matches up with the title the cat has (if applicable).
Enter any cats entered in CLASS 15 as 0 (Zero) in this column.
SIRE – sire’s full name, including titles, country codes and the EMS code in brackets at the end of the name. If the
title is NOT a FIFe title, then the organisation of origin should go before the title e.g. GCCF Ch
DAM

- as SIRE.

Exhibitor – Exhibitor’s name. USE the format “Surname, First Name” – this ensures that it is consistent with other
names, and makes sorting/comparing much easier. PLEASE ENSURE THE COMMA IS INCLUDED AFTER THE
SURNAME!
BREEDER – as Exhibitor
REG.NO – Registration number from form – ALL cats should have a registration number as a rule. Applied for is
acceptable for young kittens that are being registered with FB. Others should be checked with the FB registration
department to ensure all cats are exhibited as they would be registered by FIFe.
Saturday / Sunday – checkboxes to indicate which days the cat is entered for.
The entries are checked for basic correctness, and will highlight any problems as you enter them. Column ‘O’ (NULL)
and ‘AC’ (CHECK) are used to provide feedback.
If there is a problem with the entry, you will see '#N/A' in column O – if everything is OK, a number will be displayed in
this column. The program also checks the cat's date of birth, class and SEX, and highlights any errors in column AC.
Once you've entered the DOB, sex and class, either 'OK' or the nature of the query is displayed. Domestics will always
show an empty cell in column AC.
IF THE INFORMATION IN THE DATABASE OF CATS (i.e. what the program automatically fills in) DOES NOT MATCH
WHAT THE EXHIBITOR HAS WRITTEN ON THE ENTRY FORM DO NOT ASSUME THAT THE EXHIBITOR HAS GOT IT
RIGHT – THE EXHIBITOR OFTEN PUTS DOWN INCORRECT INFORMATION. IF THERE IS A DESCREPENCY, QUERY IT. IT
IS IMPORTANT TO GET IT RIGHT AT THIS STAGE, AS IT CAN BE TOO LATE AT THE SHOW. TALK TO THE EXHIBITOR,
OR CONTACT THE SHOW COMMISSION OR REGISTRAR TO SEE IF THEY CAN HELP.
The ‘Breakdown’ sheet is used to record who's paid what and how many cats are entered. There is a column for each
exhibitor to indicate how many pens they want of each type (single pen, double pen 1, 2 or 3 cats sharing), which side
classes they're entering if any and how many EXTRA catalogues and/or entry passes they've paid for (each exhibitor
gets one entry pass and one catalogue in their entry fee). Sharing info is recorded on the brown envelope (see below).
As you process each entry, write out an envelope for each exhibitor - write on it the name of the exhibitor (please
always write the surname first - and do it in this format in the spreadsheet also), list all the cats they've entered
(bracket together those cats sharing a pen - put the bracket to the RIGHT of the names) leaving space to the left for
the cat number to be added and to the right for the pen number to be added, and at the bottom of the envelope put
how many passes & catalogues they're getting - this is the TOTAL number INCLUDING the one catalogue and entry
pass they get free as part of their entry.

NOTES ON SHOW PREPARATION FILES
These automated processes have been developed on Microsoft Office 2003 running on
a PC with Microsoft XP Professional.

A number of more advanced Office features are used, in an attempt to automate the
process as fully as possible, and this means that no guarantees can be given
regarding how successfully (or not) they will work on previous versions of Windows or
Office, since they have not been tested.

A basic understanding of Microsoft Word & Excel is assumed.

BEFORE YOU START
Many of the following templates make use of macros and/or Visual Basic scripts. In order to
run these, you must check that your copy of Word and Excel have the required security level
set. The recommended setting is ‘MEDIUM’, which will ensure that you are asked to allow
macros whenever a file using them is opened.

To set the security level, select the menu option Tools->Macro->Security. Choose the
Medium setting, and select OK. You only have to do this once – Word/Excel will remember
this setting unless explicitly reset. The security setting must be set to at least medium – if set
to LOW, the templates will not work fully. For Office 2007 the Office Trust Centre, found in
the main options pane, is used to change macro permissions.

When opened, the template files that use macros/scripts will produce a warning indicating that
the file contains macros, and that they may be harmful. These files contain nothing harmful,
and you must choose ‘Enable Macro’ for them to work as intended.
You may be prompted asking if you want to execute the embedded SQL query. This is a
result of how some of the templates work, and appears to vary with different versions of
Microsoft Office. It should be OK to select ‘No’. If you select ‘Yes’, you wish to continue, you
will be prompted to find a data source, browse to where you have saved your spreadsheet
containing the entries, and select it.
The custom scripts have, in general, been made accessible via the toolbar (to the right of the
menu options – usually to the immediate right of Help) and on the File-> menu. Remember,
Microsoft Office applications often ‘hides’ options it thinks you will not use often, so if the
macro/script referred to is not visible, expand the toolbar or menu fully, and this will almost
always reveal the ‘missing’ option! In Office 2007 they will appear under the ‘Add-Ins’ menu.

Toolbar shortcuts are executed by clicking on them once. Menu shortcuts are executed in the
usual way, by selecting the option from the menu.
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THINGS YOU WILL NEED
Before you begin (ideally well before you need them, so as to give yourself plenty of time to
source them should any difficulty be encountered), you should also ensure that you have all
the equipment needed to produce the paperwork:
•

A general purpose printer – ideally quick (laser printer is best – one can be loaned to
the club by FB). Must be able to print on card of 160gms, and paper sizes of A4, A5
and index cards of 6”x4” and 5”x3”. These are for the default templates – A5 for CoA,
6”x4” for steward cards and 5”x3” for penning cards. If you choose to create your
own template layouts, then it will be whatever you choose to print the CoA, penning
and steward cards on. Remember, all printers are different – particularly regarding
how close they can print to the edge of the paper. Consider this when designing your
templates – some printers require margins of 10mm or more.

•

A dot matrix printer, suitable for printing on continuous stationary – for printing judge’s
report forms. The templates for these are 174mm wide and 8.5” (215.9mm) length,
and a custom page size must be set up for this. To set a custom page size under
Windows XP, select ‘Printers and Faxes’ and choose the File->Server Properties
menu option. Click on ‘Create a new form’ so that it is ticked. Type in a Form
name, for example ‘FB JUDGE FORM’, but the actual name is not important. Now
enter the form size, as above (width 174mm, height 215.9mm), with margins of 0mm.
Now click on Save Form, and then Close.

•

Pre-printed club Certificate of Award card blanks OR blank ~160 gms A5 cards if
using a template that includes the entire CoA design. You will need one for each cat
entered in competition, and a few spares.

•

A4 paper. You will need 2 different colours – one white, and one of your choice
(often a club colour). (for 200 cats, circa 30 sheets per judge of each colour). Extra
white required for other show papers – around 50 sheets.

•

Judges report form stationary – supplied by FB.

•

Pen card blanks – 3” x 5”. One for each separate pen.

•

Steward card blanks – 4” x 6”. One for each entry PLUS those needed for he BIS
panel. The number needed for the BIS panel will be at most 6 x (the sum of the
number of categories being judged by each judge). For example, if you have 3
judges, one judging 2 categories, and two each judging 3 categories, then you will
need a maximum of 6 x (2 + 3 +3) = 48 cards for BIS panel.

The template files are exactly that – templates. They are intended to be customised so that
you can achieve your own clubs ‘look’. You may use them ‘as is’, if you like, or completely
change the layout. As a minimum, you will want to change the club logos – those included
are purely to indicate the usage of a logo.
Using the 2-day spreadsheet
In order to support 2-day shows, the program allows you to enter a cat’s details once, and
indicate which day(s) it’s entered for. For a one day show just always use one day for
entering details (usually Sunday).
Use the option at the top of the ‘Entries’ sheet to select Saturday or Sunday. When entering
exhibit details it doesn’t matter what this is set to. It is important that you have this set
correctly when you do any of the following, as this information is specific to a particular day:
1. Enter the name of the judge for a cat on each day
2. Enter the class (when first switching from Saturday to Sunday, if there is no class set
for Sunday the programme will copy across the Sunday class for you. This will
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normally be the case. If not, it can be manually overwritten in Sunday for affected
cats).
3. Entering results
4. Entering details into the ‘Show Details’ sheet – judges, specials, venue, date, etc.
There is also an additional field in ‘Show Details’ – the club name at the top. This will be used
to automatically complete some of the templates.
For 2-day shows it is suggested that you first select Saturday, save the spreadsheet
and create all the paperwork for Saturday. Then open the spreadsheet again, select
Sunday, save the spreadsheet and create all the paperwork for Sunday. It is
recommended that the show spreadsheet is NOT open in Excel whilst the template
macros are used.
There are 2 changes from earlier version for entering exhibits:
1. There is now a tick item at the bottom of the entry dialogue to select which days the
cat is entered.
2. The search algorithm has been changed – it now looks for similar occurrences of
what you have typed within the names of cats in the show database. The best way to
use this is to type in a part of the names e.g. for Michealmus Sienna Sunrise you
could enter ‘Sienna’ or ‘Sunrise’ or ‘Sienna Sunrise’, and it will match all similar
occurrences. The less you type, the more matches you get.
Please ignore the side class option – this feature is not, as yet, supported.
FILES INCLUDED WITH THIS DISTRIBUTION
NB – please do not re-save the template files after running the macros; some of the
content is dynamic, and doing so may affect using the templates in the future. Once a
file has been generated, save it as a new name specific to the show. If you wish to
modify templates, this must be done without having executed the macros and the new
template file save before using the macros.
Assessments.doc – this is a template file used to create the sheets used for colour
assessments, control classes and novice classes. This file is not in any way automated – you
must create the needed sheets manually, using this template as guidance, for the cats in
these classes. These documents should be sent to the FB registrar after the show. Each one
must be signed by 2 judges who have assessed the cats. There should be a separate sheet
for each cat, and please print in duplicate so that the exhibitor may take one cope, and the
club send one to the Registrar.
Attendance Form.pdf – used on the gate and by the vets to record attendance and
successful (or not) passing of the veterinary examination.
Catalogue creation two column A4.doc & Catalogue creation A5 – this automated
template will generate all the entries for the catalogue. The script is called
Project.NewMacros.Create_Entries. Execute the script, at which point you will be prompted
to choose the spreadsheet containing the entries. Save the resulting file ready to use in your
catalogue template. The document uses styles, and these can be redefined to match your
own club’s ‘look’, if you so wish. If you wish to see a list of the Styles used, and where they
are used, contact the author.
The rest of the catalogue is manually edited in Word. It is recommended that you start with a
catalogue from a previous show, since much of the content is either duplicated, or needs little
editing to be suitable.
CoA Template.doc - standard FB CoA card generator. The script is called
Project.NewMacros.Create_CoA. It is now no longer necessary to enter the name of the
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venue and the date of the show – these will be read from your show data in the spreadsheet.
Execute the script, at which point you will be prompted to choose the spreadsheet containing
the entries. Save file for printing later, or print immediately, as required.
Cross Ref matrix template.doc – this file is only necessary if you number and file your
entries in the order in which you receive them. This template will produce a grid that allows
you to look up which cat number equates to which numbered entry form. The script is called
Project.NewMacros.Create_XRef_Matrix. Execute the script, at which point you will be
prompted to choose the spreadsheet containing the entries. Attach the generated matrix to
the front of your file containing the entry form.
FB JUDGES FORM TEMPLATE.doc – this automated template will generate the judges
report forms. The script is called Project.NewMacros.Create_Judges_Forms. It is now no
longer necessary to enter the name of the venue & club and the date of the show – these
will be read from your show data in the spreadsheet. Execute the script, at which point you
will be prompted to choose the spreadsheet containing the entries. Save file for printing later,
or print immediately, as required. Prints to FB continuous stationary on a dot matrix printer.
FIFe Steward Cert – the standard document for steward certificates.
Judges book intro.doc – this is just an example of a welcome sheet for judge’s book.
Judges Expenses.doc – example of sheet that should go into judge’s book for their
expenses claim on the day of the show.
Judges sheets.doc – this automated template will generate the judges sheets for the judges
books. The script is called Project.NewMacros.Create_Judges_Sheets. It is now no
longer necessary to enter the name of the venue and the date of the show – these will be
read from your show data in the spreadsheet. Execute the script, at which point you will be
prompted to choose the spreadsheet containing the entries. Save file for printing later, or
print immediately, as required.
These sheets go into the judges books in duplicate – one set on white paper for the
secretariat, and one copy on coloured paper for the judge to keep if they wish.
This file will also be used on the day of the show to create master sheets for the secretariat
and stewards. This print out will incorporate and changes made on the morning of the show
(due to mistakes in the catalogue, colour assessments, etc) and list absent cats.
JudgingLists (table).doc – example front of table sheets – designed for A3 paper, but can
be done as A4 if you do not have an A3 printer. These sheets have to be created manually.
Nomination sheets.doc – example of sheets that should go into judge’s book for submission
of their nominations. This is currently a manual task, and the example document a little
cumbersome to use – especially if you do not understand how Word handles sections.
Rather than try to include ALL judges in one document (which the use of sections allow), it
may be easier to have separate copies of the Nomination sheets for each judge.
How many sheets each judge gets will depend upon the Categories they are allocated for the
day.
Pen cards template.doc – this automated template will generate the pen cards. Before you
run this script, you need to have created the penning database. You do this in the entries
spreadsheet, by pressing in the Create Penning Database button along the top of the entries
sheet. This generates the information needed by the following script (which will not work
correctly unless you have completed this step). You do not need to generate cards for Sat &
Sun if the show is a 2-day show, since this template will create cards for both days, if a 2-day
show.
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The script to create the Pen Cards is called Project.NewMacros.Create_Pen_Cards.
Execute the script, at which point you will be prompted to choose the spreadsheet containing
the entries. Once complete, save file for printing later, or print immediately, as required. The
pen cards are designed to print on 5”x3” cards, but this can be changed by editing the
template BEFORE merging the document.
Results sheet.doc - this automated template will generate the results sheets, to be include
with the copy of the catalogue given to the judges at the end of the show. The script is called
Project.NewMacros.Create_Final_Results_Sheets. Execute the script, at which point you
will be prompted to choose the spreadsheet containing the entries.
Results_Catalogue.doc - this automated template will generate the results catalogue. The
script is called Project.NewMacros.Create_Results. Execute the script, at which point you
will be prompted to choose the spreadsheet containing the entries. The document created by
this script should be sent to the FB Show Commission with the show paperwork in order for
the show results to be verified.
Row End Letters.doc - standard single A4 sheet letters for the end of rows – the number of
letters required will depend on the hall layout you design.
Row end matrix template (no letters).doc - this automated template will generate the rowend grids for locating cats in the hall. The script is called
Project.NewMacros.Create_XRef_Matrix. Execute the script, at which point you will be
prompted to choose the spreadsheet containing the entries. Save file for printing later, or
print immediately, as required.
Steward cards template.doc - - this automated template will generate the steward cards.
The script is called Project.NewMacros.Create_Steward_Cards. It is now no longer
necessary to enter the name of the venue and the date of the show – these will be read from
your show data in the spreadsheet. Execute the script, at which point you will be prompted to
choose the spreadsheet containing the entries. You will then be asked if you want the
steward cards for the show judging (answer YES) or for the BIS panel only (answer NO). The
BIS steward cards are created on the day of the show, once all the nominations are complete.
The steward cards for the judging are created and printed before the show. Save these for
printing later, or print immediately, as required.
Important notes for the Show Manager
On receiving the entries database from your entry clerk, there are some steps necessary in
order to make the spreadsheet ready for creating the various items of paperwork:
•

Open the spreadsheet containing the entries.

•

Unprotect the Entries sheet – Tools->Protection->Unprotect Sheet

•

Set the number of entries received - Insert->Name->Define’, select ‘EntriesDB’ and
change the final number (e.g. if ‘=Entries!$A$1:$AJ$200’ then change the ‘200’ to
the number of the last row in your entries sheet – this number will be 1 higher than
the number of cats entered in the show). Click ‘OK’. Then, make sure that the
‘Entries’ sheet is the first sheet in the list along the bottom, and re-save the
spreadsheet.
NB. In the latest version of the spreadsheet (v7.0), this step should no longer be
necessary, since a change was made to automate it. I would recommend check the
value though, as it is essential to the right number of cats being used in some of the
paperwork generated.

The entries spreadsheet, as provided by the entry clerk will be complete except for you
having order the cats (Tools->Macro->Macros… and double click on Correct_Ordering),
number the cats – always AFTER ordering the entries (Tools->Macro->Macros… and
double click on Number_Entries), allocate judges and enter which pen the cats are in. Any
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mistakes in the catalogue MUST be corrected before using the spreadsheet to generate ANY
paperwork.

NEVER RENUMBER THE CATS ONCE YOU HAVE GENERTATED YOUR FIRST ITEM OF
PAPERWORK – IT WILL RESULT IN CAT NUMBERS THET DO NOT MATCH UP.
If you accept late entries after numbering the cats, you must manually add the next
available number to the late entry. Alternatively you must discard all paperwork
generated, including the catalogue entries if already done, and regenerate everything
after re-numbering.

MAKE SURE YOU TAKE A COPY OF ALL THE FILES TO THE SHOW!!! YOU MAY NEED
SOME IF THERE ARE AMENDMENTS NEEDED ON THE DAY.
The Entries Spreadsheet itself, the Steward cards template, the Judges sheets
template and the results catalogue are ALWAYS needed on the day.
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Winners Show
Up to 2011 this was traditionally held in November, but from 2013 will be at the end of
January as the FB show year is moving to match the calendar year. This is the only show in
the FB calendar that the Show Commission is formally responsible for running.
In addition to the ‘normal’ FB show awards, cat that have achieved the title of Supreme
Premier or Supreme Champion in the show year that just ended also receive an FB award.
Aford Awards http://www.afordawards.co.uk/, Thomas@afordawards.co.uk, JC001A- 6.5
x 5 Inch Jade Curve Jade Glass.
Winners Show perpetual trophies:
There are also the following perpetual trophies that are awarded:
World Cat congress Trophy for overall best In Show
Royal Canin Trophy for overall Best In Show
Birgit Solstein memorial trophy For Friendliest cat
Maine Coon guild trophy for Best Maine coon
Viking cat club trophy for Best housecat
Best Burmese Donated by Mrs Penny Bydlinski
Best Maine Coon Neuter donated by Mrs T Clarke
Overall Best in Cat I Donated by GOE
Overall Best In Cat IV Donated by GOE

Rosettes are ordered from Premier Rosettes: http://www.premiererosettes.com/
info@premiererosettes.com
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Show Year
Up to and including 2011, the show year ran from the Winners Show in November to the
final show of the year in October.
For 2011-12 the show year will run from the Winners Show in November 2011 to the final
show of the year in December 2012.
From 2013 onwards the show will run from the Winners Show in January 2013 to the final
show of the year in December 2013.
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Annual Awards Dinner
This is traditionally held on the Saturday evening of the FB AGA. Points are calculated
throughout the show year, currently (2011) by John & Caroline Tipper.

Trophies and Awards
In addition to the points awards, any cats that have achieved one of the ‘special’ FIFe awards
received an award from FB. This is from Aford Awards http://www.afordawards.co.uk/ ,
Thomas@afordawards.co.uk, trophy JC032B:
Distinguished Variety Merit (DVM), for winning 10 BIV awards over a minimum of two years
and a day - started 1 January 2008 so the first winners will be found on or after 2 January
2010!
Distinguished Show Merit (DSM), for winning 10 BIS/BOX awards over a minimum of two
years and a day
Distinguished Merit (DM), for a female cat with 5 offspring who have reached IC/IP or
higher, or a male cat with 10 such offspring
Junior Winner (JW), for winning 5 BIS awards as a kitten or junior
World Winner (WW), for winning a BIS award at the annual FIFe World Show
Supreme Champion / Supreme Premier
Perpetual trophies:

The Alexander Trophy for Overall category IV
VCC Trophy for Best new breed
The Nanna Memorial trophy for best NFO female
The Prince Dante trophy for best NFO male
The Freya shield for best NFO neuter
Selkcahcats memorial trophy for best NFO junior
The Tigganlea trophy for best NFO kitten
The MCG trophy for best overall Maine coon
Best breeder
Overall points (in addition to FB glass trophy)

FB glass perpetual trophies:

Overall kitten
Overall junior
Overall adult
Overall neuter
Overall points
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